
Page 51

Week 3 - Communication & PowerPoint

Interpersonal Skills

http://www.opencolleges.edu.au/careers/top-10-interpersonal-skills
WHAT ARE INTERPERSONAL SKILLS?

According to Wikipedia, interpersonal skills relate to a person’s “EQ” (Emotional Intelligence
Quotient). This is the cluster of personality traits, social graces, communication, language, personal
habits, friendliness, and optimism that characterise our relationships with other people

In relation to these skills during an interview consider the following. Also consider how each skill
would be useful in a work environment.

1. SELF CONFIDENCE

When in an interview, the recruiter might ask you a tricky question and you struggle to get the right
words. Failing to leave a good first impression tells the prospective employer that you are not
qualified and will not be able to carry out the duties. The interview is the place to prove to the
person on the other side that you have what it takes to deliver.

2. POSITIVE ATTITUDE
Be positive during the whole process, from writing the cover letter, to appearing in the interview
and to nailing that job.

3. COMMUNICATION
This skill is particularly important: the ability to read, write and speak clearly is essential.

4. TEAM PLAYER
Ability to work in a culturally diverse environment and get along fairly well with people from
different nationalities is also a plus.
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5. CRITICAL THINKING AND PROBLEM SOLVING
Are you generally a resourceful person? Even if you don’t have all the answers, would you be able
to look for them? Know what to do? People who take ownership and are ready to own up their
mistakes are highly regarded.

Big picture thinkers and those who can be accountable for problems, if required.

6. TIME MANAGEMENT SKILLS
Time management skills are valuable in many aspects of life, from revising for examinations to
working. You should aim to make time management into an art form. Know when to prioritise and
when to let go. Good time managers multitask or understand the importance of tackling one issue at
a time.

7. COPING WITH PRESSURE
According to the Stress and wellbeing in Australia survey. Significantly more Australians reported
moderate to severe levels of distress compared with findings of 2012.

Also, similar to previous years’ findings, younger adults continued to report much higher levels of
stress and distress compared with older Australians.

Have you got a colourful story to demonstrate your past experience of working under pressure?
Maybe you constantly had deadline stress or maybe you were working in a busy emergency
department for the local hospital. Bringing that experience to light won’t hurt.

8. FLEXIBILITY
The demand for flexible working arrangements, as well as flexible methods of study, has grown in
recent years. The Australian Bureau of Statistics reports that nearly 150,000 students are studying
online or “off-campus” in higher education alone – and that number is much higher when you
include VET students.
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9. ABILITY TO ACCEPT CONSTRUCTIVE FEEDBACK
Some people take any form of criticism personally.

1. Are you coachable and open to training or advice?

2. If a senior manager made a suggestion, how would you react?

3. If your boss pointed out an error and suggested something, would you thank them?

Accepting negative feedback gracefully speaks volumes about your character and makes you
extremely interesting in the eyes of the interview panel.

10. STRONGWORK ETHIC
A survey conducted by the Society for Human Resource Management compared the skills gap
between older workers approaching retirement and younger workers starting work found that
“professionalism” or “work ethic” is the top skill that younger workers lack. It said that
companies are finding it harder to find punctual, reliable workers today.
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Activity - Line Drawing

Brief:
One person will look at a simple line drawing and try to describe it without saying what the item is.

Resources:
Blank paper, pen, line drawing

Instructions:
Students will take turns describing the image whilst the other students try and draw it from the
description alone

Afterwards:
How did you do? Was this activity harder than you expected?
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Other Office Admin Skills
Administrative jobs need people with leadership skills. Administrators might run an office, manage
a staff or coordinate services for the entire company or organization. In small companies,
administrators might handle all the supportive services for an organization, but in larger companies,
they might be assigned to a specific area. Administrators require skills that keep an organization
running efficiently.

Communication Skills
Effective administrators are efficient communicators. They interact with people from all layers of
authority within the company and must tailor their conversations to the group with whom they
speak. Administrators have a strong command of the English language – verbally and written – and
know how to communicate their ideas and thoughts successfully to almost anyone.

Interpersonal Skills
The ability to get along and relate to people with different backgrounds and cultures serves
administrators well during their careers. They must be able to work independently or work within a
team to have a successful career.

Staff Management
Administrators may be called upon to manage the clerical staff within a company. Using
interpersonal skills, they motivate, inspire and manage a team of clerical workers successfully.
Staffing duties often require them to interview and select clerical staff for the company. Their
interviewing skills and personal insights help them to pick the right people for open jobs.

Organizational Skills
Administrators in small companies often handle a lot of responsibility. In order to stay on top of
their duties, efficient administrators use strong organizational skills. They are up-to-date on the
latest software and functions. Administrators usually juggle multiple tasks and functions that
require them to be organized and efficient.

Prioritization Skills
The ability to drop what you are doing and take a task on that requires immediate attention is a
pivotal skill for administrators. Being able to prioritize the work based upon the importance of each
task makes them valuable members of the company's administrative team.

Detail Oriented
Administrators often handle duties that require an attention to detail. Whether they are updating a
database, arranging travel schedules or purchasing needed office supplies, they must pay attention
to the details. They often are responsible for vetting documents for grammar and punctuation and
they must ensure that documents have the appropriate signatures.
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Assertiveness Types

The chart below gives some examples of the differences between Passive, Aggressive and

Assertive

behaviour

Source: http://counsellingservice.eu/tell-the-difference-between-assertive-passive-and-aggressive-behaviour
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Activity - Assertiveness Test

Brief:
Using the link provided, take the short test to get an opinion on your level of assertiveness.

Resources:
Computers, Internet Access, Internet Browser (Firefox), the link provided.

Instructions:
Search for “Activia assertiveness test”
Or
Use the link; https://www.activia.co.uk/assertiveness-test

Note down how this site considers your level of assertiveness

Afterwards:
Discuss your result with the class. How do you feel your result matches your own view of yourself?
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Personality Types

Personality typing is a tool with many uses. It's especially notable for it's helpfulness in the areas of
growth and self-development. Learning and applying the theories of personality type can be a
powerful and rewarding experience, if it is used as a tool for discovery, rather than as a method for
putting people into boxes, or as an excuse for behavior.

1. Extraverted VS Introverted
• While extroverts are social butterflies, introverts like to be alone and find their energy sapping
when in the company of others
• Extroverts enjoy social events and parties and, in fact, they energize by being in the company of
others

2. Sensing VS iNtuitive
• Intuitive people process data at a deeper level than sensing people.
• Intuitive people have more faith on their sixth sense than their sensory organs whereas sensing
people process information on the basis of what they get through their sensory organs.
• Sensing people are practical and live in the real world rather than the imaginative and the abstract
world of the intuitive.

3. Thinking VS Feeling
• Feeling is subjective whereas thinking is objective.
• Feeling is emotional whereas thinking is rational.
• Feeling is based upon our perception of right and wrong whereas thinking is based upon facts and
logic.

4. Judging VS Perceiving
• Judging and perceiving are preferences in life people have when making decisions.
• Judging means having clear cut goals and decisions in life whereas perceiving types do not like
timetables and deadlines as they are adaptable and enjoy being flexible.

Extra reading: https://www.personalitypage.com/html/info.html
http://www.differencebetween.com/
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Activity - Personality Test

Brief:
Take an online personality test to determine what your personality type is.

Resources:
Computers, Internet Access, Internet Browser (Firefox), about 15 minutes

Link:
Search for “16 Personalities”
Or
Use the link; https://www.16personalities.com/free-personality-test

Task:
Navigate to the URL and complete the multiple choice test, what type of personality do you have?
Consider how this might influence your career or working relationships with co-workers
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Microsoft PowerPoint

Microsoft PowerPoint is a presentation program developed by Microsoft, for use on both Microsoft
Windows and Apple Macintosh operating systems.

PowerPoint uses a graphical approach to presentations in the form of slide shows that accompany
the oral delivery of the topic. This program is widely used in business and classrooms and is an
effective tool when used for training purposes.

PowerPoint is one of the simplest computer programs to learn. It is the number 1 program used
worldwide for presentations. Anyone can create stunning presentations that look like they were
designed by a professional.

What is it used for?
PowerPoint presentations can be made into photo albums, complete with music or narrations, to
distribute on CDs or DVDs. If you are in the sales field, it involves just a few simple clicks to add
an illustrative chart of data or an organizational chart of your company's structure. Make your
presentation into a web page for emailing purposes or as a promotion displayed on your company's
website.

It is easy to customize presentations with your company logo and to dazzle your audience by using
one of the many design templates that come with the programs. Many more free add-ins and
templates are available online from Microsoft and a host of other websites. In addition to an on
screen slide show, PowerPoint has printing options that allow the presenter to provide handouts and
outlines for the audience as well as notes pages for the speaker to refer to during the presentation.

All in all, PowerPoint is a "one-stop-shop" to create successful presentations for the business world,
the classroom or just for your own personal use.

How is it different to Word?

● PowerPoint is for making slide presentation
● It has much better control over images and text. Meaning you can move text and images

around much easier
● It has the ‘Present’ feature for showing your finished slideshow
● Slideshows can be narrated and even recorded

How is it similar to Word?

● You can type letters and insert images in both programs.
● They both have spell checkers
● Shortcuts are mostly identical between the two
● The Ribbon is present and work similarly
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Terminology

Slide
Each page of a PowerPoint presentation is called a slide. The default orientation of the slide is in
landscape layout, which means that the slide is 11" (27.94 cm) wide by 8 1/2" (21.59 cm) tall. Text,
graphics and/or pictures are added to the slide to enhance its appeal.

Think back to the days of the old fashioned slide show, using a slide projector.

PowerPoint is an updated version of that kind of slide show. Slide shows can be comprised of text
and graphic objects or be completely covered by a single picture, as in a photo album.

Slide types
There are several different types of slides / slide layouts in PowerPoint. Depending on the type of
presentation you are creating you may use several different slide layouts or just keep repeating the
same few.

Slide types or layouts include, for example:
 Title slides
 Title and contents slides
 Content slides (for adding a chart, picture or table for example)

Transition
The way that one slide changes into the next. By default, one slide will just replace the previous.
Other styles can include wipes, swirls and falling over.

Animations
Animate an object to move when presenting your presentation. Can be applied to an image, a text
box, or even individual bullet points.



Page 63

Design Concepts

Further reading on Design Concepts
www.sitepoint.com/principles-of-design-colour

<<video in class>>

Video Name
How to Pick the Right Colors for Your Powerpoint Slides

YouTuber Name
Slide Cow

https://www.youtube.com/watch?v=N3hdg2-KP1A

Resource Site
https://colorsupplyyy.com/

Color Supply
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Good fonts vs Bad fonts

 Choose a font that looks good to you

 Ease to read

 A font can say a lot about what you are trying to achieve

 It should match the feel of the presentation

 OR the message that you are trying to convey
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Using PowerPoint

Getting Started
Click the Windows Start Button (Bottom Left Corner of the screen)

Scroll down the list of programs and click on “PowerPoint”

When you first load PowerPoint you will arrive at the screen below. From here you can start a
‘Blank Presentation,’ choose a built in template or search online for a template.
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Interface
Once you have PowerPoint open you should notice that the interface is VERY similar to Word.
You have the ‘Ribbon’ and ‘Groups’ but the main work area looks different. It has a navigation
section on the left and a main section for the slide that you will be working on.

Navigation

Work-area

New Slide
From the [Home] tab we can add a “New
Slide”

Note: The button to add a new slide has two parts,
a top and a bottom.

Pressing the top will add a new ‘Title and
Content’ slide whilst the bottom part will
bring up a menu to choose the type of slide you
want to add
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Delete Slide
To delete a slide, you can Right Mouse Click on
the slide in question and click on ‘Delete Slide’.

Alternative, with a slide selected you can
simply press the [Delete] key on your
keyboard.

Place-holders
All slides types except for the ‘Blank’ one, have place-holders. These show you where you can
click to start typing thing like headings, sub-titles and your main body of text. If you look at the
Navigation Pane, you will see that the place holder text does NOT show up there. Also, if you
‘Present’ your slide-show, you will not see this text either.
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Present
To start your presentation, go to the SLIDE SHOW tab and click either [From Beginning] or [From
Current Slide] depending on your needs.

Presentation Keys
There are sever ways to make your slide-show progress (move forwards and backwards), hare are a
few;
Forwards Backwards
[->] Right Arrow Key [<-] Left Arrow Key
[Space-bar] Key [Back-space] Key
(Left Mouse) Click (Right Mouse) Click, then select ‘Next’
[Enter] Key
{Mouse Scroll} Down (towards you) {Mouse Scroll} Up (away from you)
There are another few option that exist including;
Wireless remotes Apps (applications)

for your mobile device
(phone tablet, iPhone,
etc)

Digital pens Some almost hidden
buttons down the
bottom left of the
screen whilst
presenting

Image Sources (https://www.free-power-point-templates.com/articles/wireless-presenters-for-powerpoint-presentations/)
(https://www.windowscentral.com/how-use-your-digital-pen-powerpoint-slide-show-remote)
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Insert Pictures

Option a
Some slide types will have the option to add things other than text. Here we can see the option to
add and “Online Picture”

Option b
You can either;
click on the [Insert] tab and then click “Online Pictures” or If you have an image saved to your
computer to use, you can click “Pictures” and then navigate to where your image is saved
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Activity - Make a 3 slide presentation

Resources:
Computer with PowerPoint

Scenario:
You have been asked to present a PowerPoint presentation on a topic you are passionate about

Task:
Include;

 a title slide
 at least one image
 at least one paragraph of text
 present to teacher

Note: Save to USB, bring in next week
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Slide transitions
Transitions determine how one slide will look when it moves to the next slide.
You can choose different ones from the [Transitions] tab
Additionally, you can press [Apply To All] to add the selected transition effect to all slides OR you
can selected a different one for each slide

Animations
 From the [Animations] tab you can animate an object in your presentation.
 Select the object
 Select the animation
 Click [Effect Options] to adjust

Advanced:
[Add Animations] can be used to add multiple animations to a single object
[Animation Pane] shows the timing and duration of effects
[Trigger] changes when the animation occurs
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Adding Music Objects
Resource:
https://incompetech.com/
100% free music to use for whatever you wish. Paid (uncompressed) version available

Giving Credit:
"Cheery Monday" Kevin MacLeod (incompetech.com)
Licensed under Creative Commons: By Attribution 3.0 License
http://creativecommons.org/licenses/by/3.0/

Get songs from your instructor

From the ‘Insert’ tab, ‘Media’ group, select [Audio] and then select
“Audio on My PC”
Navigate to your USB and select one of the songs provided and press
[Insert]
A [Speaker] icon appears that represents your audio and allows you to
change when and how it plays
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When the [Speaker] icon is selected, choose the ‘Playback’ contextual tab to adjust when the sound
file starts, weather it fades in or out and even trim the audio if you do not need it all

Creating an Automatic Slide Show

To create an Automated Slide Show first go to the ‘Transitions’ tab and under the ‘Timing’ group, tick
‘After’ and set the time to “00:03:00” which is 3 seconds (1)
Then under the ‘Slide Show’ tab, in the ‘Set Up’ group, tick ‘Use Timings’(2)
Finally, click [Set Up Slide Show] and tick ‘Browser at a kiosk…’ (3) and click [OK]

2

3
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Activity - Make a multi-slide presentation
Resources:
Computer with PowerPoint

Scenario:
You have been asked to present a NEW PowerPoint presentation on a different topic you are
passionate about

Task:
Include;

 a title slide
 at least one image
 at least one paragraph of text
 an animated object
 at least two different transitions
 music
 present to teacher
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Week 3 Wrap-Up
Interpersonal Skills

Office Admin Skills

Assertiveness Types

Activity - Assertiveness Test

Personality Types

Activity - Personality Test

Powerpoint

Terminology

Design Concepts

Using PowerPoint

Activity - Make a 3 slide presentation

Design Concepts #2


